BitFlow

Getting Started with the BitFlow SDK 6.40

CONTENTS

GENERAL INFORMATION - 2

UNINSTALLING PREVIOUS VERSIONS OF THE SDK - 4
INSTALLING THE SDK - 5

INITIAL SYSTEM TESTS - 7

CONFIGURE YOUR BOARD FOR YOUR CAMERA - 8
INSTALLED COMPONENTS - 9

FIRMWARE UPDATES - 10

XIMILON GENTL CONSUMER - 11

DEVELOPING YOUR APPLICATION - 13

WORKING WITH THIRD PARTY SOFTWARE - 15
TROUBLESHOOTING YOUR SYSTEM - 16

GETTING HELP - 19

BitFlow, Inc. ® 400 West Cummings Park, Suite 5050 ® Woburn, MA 01801 ® 781-932-2900 ® www.bitflow.com



Getting Started with the BitFlow SDK 6.40

GENERAL INFORMATION

Before Installation

1. You must log onto the computer using an account that has administrative
privileges.

2. Uninstall any previous BitFlow SDK releases before installing this release.
See "Installed components” on page 9 for more information.

3. You should install the SDK first, before installing any BitFlow boards in your
computer. The installation process will be simpler if the Windows finds a new
board after the drivers have been installed.

4. If you are upgrading from a previous release, please be sure to read the
"“\BitFlow SDK 6.40\Docs\changes.txt” file to see what is new and what has
changed in this release.

5. This SDKis compatible with 32-bit and é4-bit versions of Windows XP, Server
2003, Server 2008, Vista (with one exception, see next section), Windows 7,
Windows 8 and Windows 10. The Road Runner, and R3 family are only sup-
ported on 32-bit operating systems. The installer will automatically detect your
operating system and install the correct 32-bit or 64-bit files.

Secure Boot

Starting Windows 10, Microsoft is requiring all drivers be attestation signed.
This is an extra layering of driver signing that attempts to make Windows 10
more secure. Note that this requirement is only enforced if Windows 10 is
installed an on system with secure boot turned on (in the BIOS). Starting with
SDK 6.30 BitFlow drivers are attestation signed and are compatible with Win-
dows 10 running in secure boot mode.

Windows Compatibility Notice

Windows 7 x64 - Microsoft is moving away from SHA-1 certificates for driver
signing. This release uses a SHA-2 certificate. The initial release of Windows
7 did not support SHA-2 certificates and the driver in this release and future
releases will not work. However, Microsoft has issued an update that fixes this
problem. If you have been updating your Windows 7 system regularly, you
will already have this fix. If you have not been updating your system, you will
need to at least install the update that supports SHA-2 certificates. This can

be downloaded from Microsoft by searching for “Microsoft Security Advisory
3033929"

Windows Vista x64 - the problem described above also exists on the 64-bit
versions of Windows Vista. As of the time of this release, Microsoft has not
released a fix for this operating system. The only option is to upgrade your OS
or use and older version of the BitFlow SDK.

Windows XP, Windows Server 2003, Windows Vista 32-bit, Windows Server
2008, Windows 7 32-bit, Window 8.x and Windows 10 - there are no known
compatibility problems.

Serial Numbers

If you purchased the SDK, you will be emailed a serial number. If you are
upgrading a computer from a previous release of the BitFlow SDK, your serial
number will already appear in the installer dialog. If you are using a third party
application (e.g. LabView, HALCON, MATLAB, VisionPro, etc) or just want to
run our simple example applications, you can install the “drivers only” version
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of the SDK by using the serial number “0". There is no charge to use or install
the SDK using the serial number “0".

Firmware Updates

New SDKs generally ship with updated firmware. The updates include any bug
fixes that might have been found since the last release, as well as new features.
For Gen 1 BitFlow boards (Karbon, Neon), new firmware is automatically down-
loaded to the board when the system powers up. For the Gen 2 boards (Aon,
Axion and Cyton), the firmware must be manually downloaded. See “Firmware
Updates” on page 10 for further information.

Running 32-bit Applications on 64-bit Windows

Starting with SDK 5.60, 32-bit applications are supported on 64-bit Windows.
If you are planning on running 32-bit applications on 64-bit Windows please
select the option “Install 32-bit binaries on 64-bit Windows". Selecting this
option will cause both the 64-bit and the 32-bit binary components to be
installed. With both types of binaries installed, both 32-bit and 64-bit applica-
tions will run correctly on 64-bit Windows.
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UNINSTALLING PREVIOUS VERSIONS OF THE SDK

Before installing SDK 6.40 you must uninstall the previous SDK
using the following instructions:

1. Open the list of uninstall options
For Vista/Windows 7/Windows 8/Windows 10:
Control Panel > Programs > Uninstall a program
For Windows XP:
Control Panels > Add or Remove Programs
2. Navigate to "BitFlow SDK X.XX" and click “Remove” or “Uninstall”

3. Follow the instructions of the uninstaller
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INSTALLING THE SDK

Install the SDK

1. Run the installer executable to start the process.
2. Follow the instructions of the installer.

3. When the installer is finished, turn the computer off and install your BitFlow

board(s).

4. If you are upgrading and have left your boards in your system, you may be
need to reboot your computer when the installation is complete.

A Note on Driver Installation

When the installer is installing the kernel level driver, windows will prompt you
asking you if you want to allow this action. On Windows XP systems, a dialog
will pop up that says “The software you are installing has not passed Windows
Logo testing...", please press the Continue button in this dialog. On Vista
through Windows 7 systems, a dialog will pop up saying that you are about to
install a driver from BitFlow, Inc. Please press the correct button in this dialog to
that you wish to continue (you can also check "Always trust BitFlow, Inc". if you
wish). On Windows 10 systems you will not see a driver installation message.
Install your BitFlow Hardware

1. Make sure you observe proper static protection procedures when installing
any hardware in a PC.

2. Make sure the PC is powered down and is not connected to the AC
supply.

3. Open the PC. Locate an unused PCl or PCle slot of the correct type for you
board. See the illustration at right to help identify the correct type of slot.

4. Insert the BitFlow board in this slot. Make sure the board is firmly seated in
the PCl or PCle connector.

5. Secure the board to the PC with a screw on the edge connector.
6. Close the PC.

7. Connect your BitFlow board to your camera using a cable of the correct
type.

8. Reconnect the AC power cord to your PC.
9. Power up your camera.

10. Power up and boot your PC.
After Rebooting on Windows Vista, 7 and 8 Systems

The device drivers will be automatically installed, no interaction is required.

You may see a “bubble” in the lower right side of the screen indicating that the
driver is being installed. There will be a message indicating then the driver is
finished being installed, at this point you can proceed to test your board.

Note: it make take up to one minute on some systems before the driver instal-

lation process begins.
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After Rebooting on Windows-XP Systems

1. For plug and play operating systems, the New Hardware Found Wizard will
pop up.

2. Follow the Wizard’s instruction to install the default driver (recom-
mended).

3. Atsome pointduring this procedure, the Wizard will display a message saying
"digital signature notfound"” or “...has not passed Windows Logo Testing”. This
message is in no way an indicator of insufficient performance or functionality.
Press the Continue button in this dialog to proceed with the installation.

A Note On Windows 10 Systems

By default, when you shut down a Windows 10 system, it really goes to sleep
(this behavior can be turned off). In this case, “sleep” means that the system
state is written to the hard drive and the components are powered down. When
the system is subsequently turned back on, it actually wakes from sleep. If a
new board is installed during this cycle, the operating system may not see the
new device. The simple solution is to perform a restart (warm reboot) after the
power up after installing new hardware.
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INITIAL SYSTEM TESTS

f

Testing Your Board
1. Run SysReg (Start Menu > Programs > BitFlow > SDK 6.40 > SysReg).

2. Make sure the Camera configuration file path is correct. If you installed the
SDKin the default directory, the configuration directory should be “C:\BitFlow
SDK 6.40\Config”.

3. All of the BitFlow boards in your system should appear in the “Boards
installed” list. Highlight a board in this list then click the Board operation:
Configure button to open the Board Details dialog. If no boards appear in
this list or boards are marked “Missing”, go to the trouble shooting section.

4. Click the Camera file operation: Add button to open the Choose Camera
File dialog.

5. Navigate through the tree to the following entry:
For Aon-CXP, Axion-CL , and Cyton-CXP models:

+ Make: BitFlow
+ Model: Synthetic Area Scan
+ Mode: Dynamic Diagonal Wedge, 1024x1024, Free Runn
+ Default@BitFlow-Synthetic-AreaScan-1024x1024.bfml

Click on "Default@BitFlow-Synthetic-AreaScan-1024x1024.bfml"” and then
click OK.

For Karbon and Neon Camera Link models:

+ Make: BitFlow
+ Model: Synthetic
+ Mode: 8-bit, 1024x1024, Free Run
+ BitFlow-Synthetic-1024x1024-E1.r64

Click on “BitFlow-Synthetic-1024x1024-E1.r64" and then click OK.

For Neon-Dif models:

+ Make: Generic
+ Model: Synthetic
+ Mode: 8-bit, 1024x1024, Free Run
+ Generic-Synthetic-1024x1024-E1.ndif

Click on “Generic-Synthetic-1024x1024-E1.kcxp” and then click OK.
6. Click OK to the Board Details dialog.

7. Click OK to the SysReg dialog.

8. Now run BitFlowPreview.

9. The application will open and you should see a wedge pattern similar to the
images on the right (the image will appear to continuously shift horizontally).
If you see this image, the system is working fine. If you do not see this pattern,
go to the Troubleshooting section.

“

“

Synthetic camera output
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CONFIGURE YOUR BOARD FOR YOUR CAMERA

CoaXPress Cameras

If you are using a CoaXpress camera that is version 1.1 or later, the software
will automatically configure the board to acquire from you camera. There is no
need to run SysReg or select a camera configuration file. However, if a camera
configuration file is “attached” in SysReg, this file will take precedence, and
the system will not auto-configure. In order to auto-configure, either leave the
attached cameras list empty or attach the following configuration:

+ Make: Generic
+ Model: CXP v1.1 or later
+ Mode: Default
+ Generic-CXP.bfml

Note that there are many situations where you may want to override the auto-
matic configuration settings. For example a cameras default settings might
be 1 link at CXP-3 and you may want to run the camera four links at CXP-6. In
these situations, you can use a configuration file that specifies that configuration
parameters that you want to change from the default. It is possible to set up
a BFML file where some parameters are determined by the camera’s settings
and other parameters are manually in the file by the needs of your application.

Another situation where you may want to use a configuration file is if you need
to set up the frame grabbers I/0 functionality. Again, a BFML file can be set
up where the camera parameters are automatically configured by the camera,
but the frame grabber I/O parameters are configured by the BFML file.

Camera Link Cameras

i 1. Run SysReg.
A

2. Highlight the board in the BitFlow boards found list, then click the Board
operation: Configure button to open the Board Details dialog.

3. Highlight the existing configuration file in the Attached camera listand click
the Change button.

4. Navigate the configuration file tree to get the Make, Model, and Mode of
your camera, click on the file name, then click the OK button.

5. Forthe Aon, Axion and Cyton families, there is no need to change firmware
for different model cameras. For the Karbon/Neon/Alta families, the correct
firmware is automatically loaded to the board when it is initialized.

6. Click OK to the Board Details dialog.
7. Click OK to the SysReg dialog.
8. Make sure your camera is powered up and connected to the board.

a 9. Run BitFlowPreview again. You should see live video from your camera. If
! you do not see an image, go to the Troubleshooting section.
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INSTALLED COMPONENTS
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The following components are copied to your computer when
installing the full SDK.

Read Me - The latest information about the release

SysReg - System configuration utility: associates cameras with installed boards.
BitFlowPreview - Primary viewing application for all models and cameras.
BitFlowCapture - Sequence capture application based on the Bufin API
BiProcess - Simple continuous processing application example.

BFCom - HyperTerminal like application for camera communication through
the Camera Link board's serial port.

Circ - Circular buffer processing application example.
CamEd - Camera configuration file editor for Gen 1 boards.
CamML - Camera configuration file editor for Gen 2 boards.
PCIWalk - PCI configuration utility.

BFLog - Debug messages logging utility.

VerCheck - Displays DLL and driver version information as well as key system
parameters.

DLLs - Dynamic Link Libraries: these contain all of the functionality of the
SDK.

clserbit.dll - Camera Link serial communications DLL. This is BitFlow product
specific and is located in the “\BitFlow SDK 6.40\Bin32" and/or “\BitFlow SDK
6.40\Bin64" folder. On 32-bit systems, only the 32-bit version is installed. On
64-bit systems the 64-bit version is installed (same file name) and the 32-bit
version is also installed if the option “Install 32-bit binaries on 64-bit Windows".
is selected during the install process.

clallserial.dll - Camera Link serial communications middleware DLL. This is a
generic DLL that goes between the Camera venders application and the frame
grabber specific DLL (see above). This DLL is located in the “C:\Program Files\
CameralLink\Serial” folder. On 64-bit Windows, there will be a 32-bit version
of this DLL located in the “C:\Program Files (x86)\CameraLink\Serial” folder.

Camera Configuration Files - Used to configure the board for your cameras.
Kernel Driver - Provides access to the BitFlow hardware.
Documents - Text files with the detailed information about the release.

Source Code - Complete C and C++ source for all examples and user level
DLLs.

Header files - Definitions required for the API.
Libraries - Link libraries for the Microsoft compliers.

Firmware - These files contain the logic that is download to the board's FPGAs.
These are *fsh files located in the “\Windows\System32\Drivers\BitFlowFlash”
folder.

BitFlow, Inc. ® 400 West Cummings Park, Suite 5050 ® Woburn, MA 01801 ® 781-932-2900 ® www.bitflow.com



Getting Started with the BitFlow SDK 6.40

FIRMWARE UPDATES

Gen 1 Boards (Karbon, Neon)

The firmware for the Gen 1 boards is downloaded to the board automatically.
The BitFlow driver downloads the appropriate firmware to the board during
system boot. From time to time new firmware is released from BitFlow, either
to fix known problems or to add features. All that is required to use the new
firmware is to copy the files to the appropriate location (see below) and reboot
the system.

Firmware locations:
Road Runner/R3 - “\Windows\System32\Drivers\BitFlowFlash\RoadRunner”
Alta/Karbon/Neon - "\Windows\System32\Drivers\BitFlowFlash\R64"

Gen 2 Boards (Aon, Axion, Cyton)

The firmware for Gen 2 boards (Aon-CXP, Axion-CL, Cyton-CXP,) are stored in
nonvolatile memory and does not require downloading during system boot.
Further, the same firmware supports all known types of cameras, so there is
no need to switch firmware when the camera type changes (as there is on our
Gen 1 models). However, firmware updates may become available from time to
time from BitFlow and you may be advised to update you board. The process
below shows the steps required to update the firmware on your Gen 2 board.

If you are upgrading to a new version of the SDK, you should also update the
firmware you board(s). The new SDK will install the latest firmware on your
system.

Firmware location: “\Windows\System32\Drivers\BitFlowFlash\Gn2"

1. Open Command Prompt (console window) (Start > All Programs > Acces-
sories > Command Prompt).

2. Enter the following command:
> FWDownload

3. Follow the instructions of the FWDownload program. Note that will take up
t o 10 minutes to update the firmware on your board.

4. When FWDownload has finished, Shutdown your PC, then power it back
up (cold reboot).

5. You can run the utility VerCheck to verify the your board has been updated.
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XIMILON GENTL CONSUMER

Introduction

Ximilon is a graphical user interface tool for controlling cameras, exclu-
sively through BitFlow frame grabbers; a “consumer” implementation of the
Gen<i>Cam™ Transport Layer (GenTL)standard. The BitFlow GenTL “producer”
(BFGTL), installed by the BitFlow SDK, provides the back-end for camera
control, supporting all modern BitFlow frame grabbers. Direct control of any
CoaXPress and Camera Link camera is possible (for cameras compatible with
the Gen<i>Cam™ standard), usually with minimal technical knowledge on
the part of the user; analog cameras will be listed, but cannot be controlled.

Where to Get Ximilon

- Ximilon is not included as part of the normal SDK download. It can be down-
! ‘. loaded separately from BitFlow website’'s download page.

. i' : Software Prerequisites

In order for Ximilon to work, and to be of use, some software prerequisites
must be installed:

BitFlow SDK

Ximilon requires the BitFlow GenTL producer (BFGTL)to be installed, although
the exact release will not typically matter. Additionally, Ximilon's CLProtocol
Binding Tool will only run if the matching BitFlow SDK library installed. The
driver only release is sufficient, in each case. Download the installer from the
BitFlow website.

Gen<i>Cam™ GenApi reference implementation

New versions of Ximilon and BFGTL will always require the latest contemporary
release, although a specific Gen<i>Cam™ version is necessary. The correct
version of Gen<i>Cam™ will be installed by the Ximion installer.|

CLProtocol DLL (Camera Link only)

A Camera Link only, vendor-specific requirement, facilitating Gen<i>Cam™
compatibility. Camera vendors typically bundle this with their own SDK or
camera control utility, although the method of distribution is dependent upon
the individual vendor.

Configuration

To use a camera, BitFlow frame grabbers require that a camera configuration
file be attached to the corresponding board entry, matching the camera to
be used. Open the BitFlow SDK's SysReg utility, select the appropriate port
from the "Boards installed” list, and click “Configure.” "Add" a camera file
matching your camera’s vendor and model, and click “OK"; click "OK" again,
to close SysReg.

With a camera configuration file set, run the BitFlow BitFlowPreview applica-
tion, to ensure that image acquisition is working. The camera will need to be
connected to the computer, and depending upon the model, externally pow-
ered. Ifimage acquisition in BitFlowPreview works, Ximilon is ready to be used.

Camera Link

Additional configuration is sometimes required to register the CLProtocol DLL
for specific cameras; BFGTL will attempt to form this association automatically,
butthatis notalways possible. To manually configure the binding, open Ximilon
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and select the System Tools > CLProtocol Binding Tool main-menu entry. If
the “Port ID” matching the relevant camera is not bound to the appropriate
vendor "Device ID,” select these from the combo boxes, and click “Bind.” On
success, a matching entry will appear in the “Current Bindings” list. Close the
Tool, to use the camera.

CoaXPress

Usually, no manual configuration is required to control a CoaXPress camera
using Ximilon. However, in some cases it is necessary or desirable to control
the camera using an external GenTL XML file (provided by the camera vendor),
if the camera does not include the file internally. Loading such a file is easy in
Ximilon: Browse to BFGTL >[camera Interface] > Transport Layer Device, then
Manually Cache an XML File (only available with “Guru” Visibility) using the File
Browser. Upon success, BEGTL will reload, and a new Camera Features entry
will appear under the camera Interface.

Application Use

Upon opening Ximilon, the user will be presented with one or more GenTL
Interfaces, with either generic names, or names corresponding to the set
camera file. With a camerafile set, the user should select to the Interface, then
Camera Features, to access the configuration features of the camera itself.
The features available are specified by an XML file typically retrieved from the
camera itself, and will vary from vendor-to-vendor, and model-to-model. If
the Camera Features label includes the term “Fallback,” no XML file could be
loaded. This will always be the case for analog cameras; additional Configura-
tion may be necessary to use Camera Link or CoaXPress cameras.
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DEVELOPING YOUR APPLICATION

Once you are confident that your board is working correctly

The next step is to develop your application. The examples provided should
allow you to quickly integrate the BitFlow SDK functionality into your pro-
gram.

If you need something simple

CircularSimple - This programs show the minimum function calls required to get
images into the host memory. It should be very easy to integrate these same
function calls into your application. These applications do not provide a GUI.
However, they are extremely easy to understand and build upon. Because the
example CircularSimple uses the Bufln API, it works with all product families.
It is recommended that you start with this example as it will provide the most
flexibility in the future.

If you need to view and save live images

BitFlowPreview- This application demonstrates real-time display with a fully
zoomable display window. Images can be saved to disk from the File menu. If
you are using a Gen 2 board, you can switch between modes in the BFML file.
Raw outputfrom Bayer color camera cameras will be de-mosaiced in software
and display in full RGB color.

If you need real-time processing

BiProcess, BayView, Circ - These applications demonstrate multiple host
buffer acquisition. The buffers are used in a circular manner. Each buffer in
turn receives DMA data from the board, while the other buffers are available
for processing. This allows the CPU to access an entire image without data
being overwritten by the board. BiProcess dces a simple histogram calcula-
tion, BayView performs a de-mosaicing operation on the incoming images
and Circ simply displays each image in turn. All of these examples are good
starting points for your application, you just need to plug in your own process-
ing functions.

If you need to acquire sequences of images

BiFlow - This application acquires sequences of images in real time to host
memory using the Bufln API. The resulting sequence can be displayed one
at a time on the VGA, played back as a sequence and/or saved to disk. This
application captures images in the cameras native format (i.e. pixel bit depth)
for internal storage and for saving to disk.

If you need to acquire and process images via a circular set of
buffers

Circ - This application demonstrates the circular buffer processing portion
of the Bufln API. The concept is that the board is acquiring continuously into
a set of buffers. Unsynchronized with acquisition, the host is processing the
images in the buffers. The number of buffers required is dependent on the
variability of acquisition and processing time. The Bufln APl makes this type of
an application very easy to write. Circ fully demonstrates the power of this API.
You can also click on any buffer to remove it from the list of available buffers.
Clicking on this same buffer again, re-inserts into the buffer list. This process
demonstrates the new Add/Drop buffer functionality.
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If you want to use the buffer management functions (Bufin)

BiSimple, BiSimplePlusPlus, CircClassExample, CircHoldSimple - These proj-
ect folders contain a wealth of example console program. Because they are
console programs the code is simple and easy to understand, unencumbered
by messy GUI code. These examples illustrate most of the major components
of the Bufln interface, in both C and C++. Each example is a self-contained
lesson in an important feature of the Bufln API.

Whatever example you decide to start with, you must build and modify it with a
C compiler. We provide source and projectfiles to build all of our examples with
Microsoft Visual Studio 2005, 2008, 2010, 2012 or later. However the BitFlow
APl is fully WIN32 compliant and can be called from any WIN32 programming
environment, for example Microsoft Visual Basic. Please refer to the “readme.
txt” file to see how to get started with this and other environments.

If you want to use another programming language

The SDKinstalls all the files that are needed to write applications in both C and
C++. If you wish to build your application in another programming language,
please visit the downloads page of our web site. There you will find support
for various other languages and environments. For example, there is a .NET
download which supports programming in C# and VB (as well as other lan-
guages). There is also a driver for other environments like NI's LabView, MVTec's
HALCON and Cognex’s Vision Pro. If you can't fine what you need, contact our
technical support department to see if they can help you.

If you need to understand how your board works

There is a hardware reference manual for each family of boards. These manuals
are available on the SDK CD and can also be downloaded from our web site.
The following manuals are available:

R3-DIF - Covers Road Runner and R3 differential models
R3-CL - Covers R3 Camera Link models

Karbon-CL - Covers all Karbon Camera Link models
Karbon-CXP - Covers the Karbon CoaXPress model
Aon/Cyton-CXP - Covers the Cyton CoaXPress model
Axion-CL - Covers the Axion-Camera Link model

Neon - Covers all Neon models

Alta - Covers all the Alta models.

If you need to understand how the software works

There is a comprehensive software manual, The Software Reference Manual,
available from our web site This manual describes every function in the BitFlow
SDK APl in detail. Also included are overview chapters which describe how to
use the different APIs from a high level.

If you are using the Bufln C++ interface the documentation can be found in
HTML form on our web site. As the Bufln C++ class is just a wrapper around
the Bufln class, it will be helpful to see the Bufin functions in the The Software
Reference Manual
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WORKING WITH THIRD PARTY SOFTWARE

The functionality of the BitFlow SDK is greatly extended by the addition of
third party software. If you are going to use one of these products, then you
will need to install a driver that provides an interface between the third party
product and the BitFlow SDK. Usually you will have to install the BitFlow SDK
before installing the individual 3rd party imaging software product driver.
However, some imaging software products install the driver and/or the SDK
automatically. Please consult the documentation of the individual imaging
software product for details.

When installing the BitFlow SDK for use with third party software, you can enter
the serial number “0”, which will tell he installer to justinstall the BitFlow driver
and other binary components.

Drivers for third party software packages are available from the download
sections of our web site or from their respective vendors. All of our drivers are
based on BitFlow's Common Interface library (Ci) and will work with whichever
BitFlow board is installed in your system (i.e a single driver for all models of
BitFlow frame grabbers).
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TROUBLESHOOTING YOUR SYSTEM

Here are some simple things you can check if your system is not working cor-
rectly:

If computer does not boot, or the computer hangs during the
boot process:

This problem is usually caused by another device conflicting with the board.
Try removing or disabling all other non-critical PCl devices.

Try put the board in another PCI/PCle slot.

Try reserving the IRQ of the device conflicting with the board, this can be done
in some BIOS's.

LEDs are all blinking red (CXP boards only)

The board is plugged into a PCle slot that it is not compatible with. Please plug
the board into a compatible slot.

Windows 7 - The BitFlow driver is labeled “not digitally signed”

Please see "Windows Compatibility Notice” on page 2.

If SysReg shows an error message and does not run or no
boards appears in SysReg, or only some of your boards appear
in SysReg, or boards are marked as “"Missing":

These symptoms may be seen when upgrading a system which has a previous
version of the BitFlow SDK on it. On some system the Plug and Play Wizard
gets confused. These problems are easily solved using the device manager
as follows.

First try rebooting your computer, this often clears up many problems.
If this does not work try the following procedure:

1. Run the device manager (Start > Control Panel > Administrative Tools >
Computer Management ).

2. Navigate to the BitFlow devices (Computer Management > System Tools
> Devices > Imaging Devices OR Computer Management > System Tools >
Devices > Other Devices).

3. All of the BitFlow boards should look like the image at top-right.

4.fany boards appear with the erroricons as shown in the three lower images
attheright, then there is a problem with the plug and play configuration. To fix
this problem right click on the device in question and select Update or Enable
Follow the instructions of the New Hardware Wizard (select “Install the software
automatically”). You will see a Windows warning dialog, click continue. After
the Hardware Wizard is finish, the device should work properly.

5. Repeat step 4 for all devices that have error icons.
6. You may need to reboot your computer after making these changes.
If the synthetic image does not appear in one of the viewing

applications:
Try the board in another PCI/PCle slot.
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Remove all PCI/PCle cards except the BitFlow board and your display card.
Try the BitFlow board in another PC.
Try updating the drivers for you display card.

If you get time out errors in one of the viewing applications
with your camera:
Make sure your camera has power.

Check the cable between the camera and the board to ensure all the connec-
tors are tight.

Make sure you have selected the correct configuration file for your camera.

Make sure your camera is set in the mode for which configuration file was
designed.

If you are using an encoder or trigger, make sure that they are sending the
correct signals to the board (see the hardware reference manual for interface
specifications). Confirm that the camera works in free running mode first.

Check the overall PCI/PCle DMA throughput using the application CiBench .
Your system should be at least 20% faster than your camera’s data rate. If you
are unsure of your camera’s data rate use the following formula:

DataRate (MB/S) = CameraTaps x PixelClockFrequency x BytesPerPixel
Where:

CameraTaps = The number of data streams coming out of the camera (usually
correlates with the sensor design).

PixelClockFrequency = The frequency of the data strobe clocking out the
pixel data.

BytesPerPixel = 1 (for monochrome or 8-bit cameras)
BytesPerPixel = 2 (for cameras with 9 to 16-bit pixels)
BytesPerPixel = 3 (for packed (RGB) color cameras)
BytesPerPixel = 4 (For unpacked (ARGB) color cameras)
MB/S = Megabytes per second

The formulas define the maximum possible data rate produced by the camera,
the average data rate may be somewhat slower.

If the video display is blank and you don’t get time out errors in
one of the viewing applications:
Check the lens cap and F-Stop settings.

Try pointing the camera directly at a light or window. Some cameras need a
very bright light to provide an image.

Check your camera’s gain and other adjustments.

If you get video but it is skewed, scrolling or looks out of sync:

Double check that you are using the correct camera file for the camera you
have attached to the board and for the mode that the camera is in. If you are
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not sure which camera file to use, edit the file in CamEd, and check to make
sure the comments in the file agree with your camera/mode.

Make sure that you are using the correct firmware for your camera .

If your camera has a binning mode, make sure that your are using a binning
camera file.
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GETTING HELP

There are many resources, beyond this document, that are
available to you if you have trouble getting started:

The manuals There is a wealth of information in both the SDK manual as well
as the individual hardware manuals.

Our web site: www.bitflow.com

E-mail: support@bitflow.com

Telephone 781-932-2900 (9 AM-6 PM EST)

Facsimile 781-933-9965

Please have the following available when seeking support:
Model and serial number (on a small yellow sticker) of your board.
Make and model of camera and mode being used.

Manufacturer and model of camera cable.

Installation information, run VerCheck, save the output to a text file.
Computer CPU model, mother board make and model.

Operating system, service pack.

Example code (if applicable).

The Windows Event Viewer System log from the period of time when the
problem occurred. Save the file as a *.evt or *.evtx file.
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